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Overview 
Orbitscreen is a Motif' program to display arrays of process variables from the Advanced Photon 

Source control system. Although, in principal; any two arrays of process variables may be displayed, the 
most common use is to display the horizontal and vertical monitor readings. 

There are three display areas in the interface, one for each of the arrays and a zoom area. In the 
zoom area both arrays can be displayed at once along with symbols for the major elements of the lattice. 

There are a number of options to customize the way the values are displayed. It is also possible 
to: 

0 

0 

0 

0 

0 

Store the current values internally 
Store the values from a snapshot file internally 
Display one of the stored sets of values along with the current values 
Display the difference of the current values with one of the stored sets of values 
Write the current values to a snapshot file 

' 

The program continuously updates and displays the standard deviation, average, and maximum 
absolute values for each array and will show the envelope of recent values if desired. (The standard 
defined with n rather than n-1 is used since the whole population is known.) The values are sent to the 
program anytime they change outside of their dead band. If the dead band is chosen appropriately, this 
should result in less traffic over the control network than if all of the values were polled at fixed intervals. 
When the display updates, the current values that have been received are displayed. It is possible to 
manually update all the variables via the OptionsEPICSRescan menu. 

A PV file determines which process variables are displayed in each array and other things such 
as units and scaling. A lattice file specifies the symbols and longitudinal lattice positions of the elements 
in the lattice. Sets of values can be saved and restored via snapshot files, and the difference with the 

'Motif is a standard graphical interface for X Windows systems. It is characterized by a three- 
dimensional look and feel. 



values in these files or other saved sets of values can be displayed via options in the Options menu. 

I: 

Fig. 1 The Orbitscreen Interface 

Getting Started 
In order for Orbitscreen to run properly, it needs to find the orbitscreenrc file. (It is possible to 

run Orbitscreen without the orbitscreenrc file, but it is not suggested.) This file contains the Fi lehad 
menu options and the locations of other files that Orbitscreen needs. There are three main ways to allow 
Orbitscreen to find the orbitscreenrc file. 

0 Put this file in your home directory, call it .orbitscreenrc (with a dot), and start Orbitscreen 
from anywhere. All of the directory and file locations should be specified (using full 
pathnames). 
Change to any directory where an orbitscreenrc (no dot) exists, and start Orbitscreen there. 0 



0 Set the environmental variable $ORBITSCREENHOME to the directory where 
orbitscreenrc (no dot) is located, and start Orbitscreen from anywhere. 

The contents of orbitscreenrc are described under configuration. 

The command line for Orbitscreen is of the form: 

orbitscreen [Standard X Options] [-XI 

It accepts any of the standard X-Window options, such as -display machine:O. The other option is: 

-x Use Xorbit Simulation Mode. 

Upper Two Display Areas 
In the upper two display areas the values of the process variables are displayed in graphical form 

with uniform horizontal spacing between the points. Display options, such as whether the values are 
displayed as a line plot or as an impulse plot, are determined by settings that can be made in the View 
menu. There are mouse operations for displaying the numerical values of the three elements closest to the 
mouse cursor and moving the m m  window so the element closest to the mouse cursor is in the center. 
There are options in the View menu to show the region between the maximum and minimum values 
achieved for each process variable since the last reset. The Reset Max/Min switch is in the Options menu. 

The scale of the window can be changed by a control above it. The displayed range extends from 
the negative of the value on the Scale button (at the bottom) to the positive of the value (at the top). The 
starting scale and a factor by which to multiply the raw data to get the desired units are set in the PV file, 
which also determines which process variables are displayed and the heading and units. 

The standard deviation, average, and peak absolute values are shown and updated when the 
values are updated. (The standard defined with n rather than n-1 is used since the whole population is 
known.) The peak absolute value includes the sign of the value that was largest. The update time interval 
can be changed in the ViewRiming menu. 

Zoom Area 
Both sets of values are shown together in their true relative lattice positions in the zoom window; 

along with symbols representing the lattice elements. The values from the upper display area are red-by 
default and those from the middle display area are blue. There are mouse operations that scroll the 
window as well as controls above the window to change the size of the interval of the lattice displayed, the 
sector, aqd to scroll by a display interval one sector at a time. The m m  area can also be scrolled by 
clicking in the upper two display areas. The sector shown in the box labeled Sector: is the sector that is at 
the center of the display area. In addition, numbers designating the sectors and a mark identifying the 
center of the display area are displayed in the display area to help identify the sectors and the midpoint for 
mouse scrolling. 

The scale of each of the curves in the zoom window can be changed by the controls above it. The 
left control corresponds to the upper display area and the right, to the middle. The scale corresponding to 
1.0 is set in the PV file, which also determines which process variables are displayed and the heading and 
units displayed. 

Other options controlling how and which curves are displayed are found in the Options/Zoom 
Options menu. The zoom area can be turned off entirely, and it does not appear if the process variables 
cannot be matched with the lattice elements in the lattice file. 



Mouse Operations 
In the upper two display areas: 

Button 1: 

Button 2: 

Pushing and holding Button 1 brings up a dialog box with the numerical values of the 
three elements closest to the mouse cursor. The dialog box goes away when you release 
the mouse button within the display area. If you want the box to stay up, drag the mouse 
cursor off the display area before releasing it. 

Pushing Button 2 moves the element closest to the mouse cursor to the center of the 
zoom area. 

In the zoom area: 

Button 2 

Button 3: 

Pushing Button 2 moves the point under the mouse cursor to the center of the m m  
area. (Similarly to what Button 2 does in the upper two display areas.) 

Pushing and holding Button 3 scrolls the zoom area horizontally. The scroll speed is 
proportional to the distance of the mouse cursor from the center of the mom area. You 
can scroll either direction, depending on which side of the center you hold the mouse 
cursor. 

File Menu 
Load 

The Load button brings up a menu of predefined configurations that may be loaded into the 
display. Each configuration corresponds to a PV file and the associated lattice file. As soon as the 
configuration is loaded, monitoring starts. The configurations on the menu should be the most commonly 
used ones. If you wish to speci@. another configuration, you may pick the menu item labeled Custom. In 
that case, a file selection dialog box to pick the PV file will appear. The items that appear in the menu are 
specified in the configuration file. 

Read 
The Read button brings up a menu of possible slots in which to store data from a snapshot fiIe. 

After choosing the slot from the menu, there will be a file selection dialog box to allow you to pick the 
snapshot file containing the data. The data stored in the slot can then be used for displaying or 
differencing with the current data. 

Write 
The Write button allows you to store either the current data or the data saved in one of the slots 

in a snapshot file. It brings up a menu which includes the current data and the possible slots. After 
choosing the current data or the desired slot, there will be a file selection dialog box to allow you to pick 
the snapshot file into which to write the data. 

Plot 
The Plot button brings up an SDDS plot of either the current data or the data saved in one of the 

slots. 

. 
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Status 

loaded into slots. 
The Status button brings up a dialog box with information about the configuration and the data 

Quit 
The Quit button closes any Channel Access connection and terminates Orbitscreen. 

Options Menu 

EPICS 
Normally, using File/Load is sufficient to perform the required EPICS procedures. This item 

provides more control over EPICS. The Start button will initialize EPICS if it is not initialized and start 
it with the current PV file. If it is stopped, it will start it and rescan the process variables. Initialized 
means connections have been established with all the process variables. Started means it is initialized, is 
receiving messages whenever those values change outside of their dead bands, and is updating the display. 
When it is started, the Start button changes to a Stop button. Consequently, this button also tells you 
what state it is in. The Stop button leaves it initialized but not receiving messages and not updating the 
display. You can play with the existing data. The Exit button stops it and closes the connections, so it is 
no longer initialized, The Reinitialhe button is equivalent to Exit followed by Start. The Rescan button 
causes it to explicitly update all the values whether they have changed out of the dead band or not. It 
insures the readings are current. 

Store 
The Store button allows you to store the current values in one of the available slots. The status of 

what is stored in the slots can be displayed with the File/Status button. 

Display 

addition to the current values. They will be a different color. This capability allows you to compare the 
current values, which are being updated, with some other set of values. No Stored Values turns off the 
display of these other values. The status of what is stored in the slots can be displayed with the File/Status 
button. 

The Display button allows you to display the current values from one of the available slots in 

\ 

Difference 

one of the available slots. This .capability allows you to see the changes in the current values from some 
other set of values. Off turns off the differencing. The status of what is stored in the slots can be 
displayed with the File/Status button. 

The Difference button allows you to display the difference of the current values and the values in 

Check Status 
The Check Status button allows you to choose how much status information is displayed. The 

choices are Off (do not display status symbols), Check InValid (display symbols only for invalid 
readings), and Check All (display all status symbols). Orbitscreen still receives all status information 
regardless of these choices. The choices only determine how much of the information is displayed. The 
button is only operational if status process variables have been specified in the PV file. 



Zoom Options 
The Zoom Options button gives access to several controls that affect the zoom window. You can 

toggle on and off the display of lines or markers for the values in the upper (xl) or middle (x2) display 
areas and toggle the display of grid lines on and off. The zoom window display can also be turned entirely 
on and off with the Active toggle button. Turning it off will save processing time. It will be off in any 
event, regardless of the setting of this button, if the process variables cannot be matched with the lattice 
elements. 

Reset Max/Min 
The Reset M d i n  button resets the stored maximum and minimum values for each process 

variable to the current values. This effectively restarts the maximudminimum history. The display of 
the history is controlled by the Max/Min and Filled Max/Min options in the View menu. 

View Menu 
Timing 

that new values are received by Orbitscreen when the process variables go out of their dead band. These 
values are collected and are displayed only when the screen updates. 

The Timing button brings up a dialog box that lets you change the screen update interval. Recall 

Markers 
The Markers toggle button toggles whether markers are shown or not for the data points in the 

upper two display areas. 

Lines 

two display areas. If Bars are chosen, then Lines will not be, however. 
The Lines toggle button toggles whether lines are shown or not for the data points in the upper 

Bars 
The Bars toggle button toggles whether impulse lines are shown or not for the data points in the 

upper two display areas. Bars overrides Lines. 

Grid 

areas. 
The Grid toggle button toggles whether grid lines are shown or not in the upper two display 

Max/Min 
The Max/Min toggle button toggles whether the maximum and minimum values for each process 

variable since the last reset are shown or not in the upper two display areas. The maximum-minimum 
history is reset with the OptionslReset M d i n  button. 

Filled Max/Min 
The Filled Max/Min toggle button toggles whether or not the area between the maximum and 

minimum values is filled with gray. Filling the area makes it easier to see where the values have been 
during the history period. It does nothing if the M a n  button is not set on. 



Double Buffer 
The Double Buffer toggle button toggles whether the updating of the display is double buffered or 

not. If it is double buffered, the screen is updated in the background and displayed all at once. This is the 
most pleasing option. Otherwise, you can see the lines being drawn as the screen is updated. You might 
use no double buffering to check that the updates are occurring, but usually there is no reason to change 
this setting. 

Clear Menu 
Clear 

The Clear button clears all three display areas. Unless EPICS is stopped, they will be redrawn at 
the next scheduled update. 

Redraw 
The Redraw button redraws all three display areas with the last values used, not the current ones. 

Unless EPICS is stopped, they will be redrawn at the next scheduled update anyway. 

Update 
The Update button redraws all three display areas with the current values. Unless EPICS is 

stopped, they will be redrawn at the next scheduled update anyway. 

Autoclear 

another way to obtain a history of the values. 
The Autoclear button toggles whether new values erase old ones or not. Turning Autoclear off is 

Correction Menu 
The Correction Menu has not been implemented at this time and may not be. 

Installation 
In the typical, standard installation there should be a directory in which most of the Orbitscreen 

files are found. The files that should be in this directory are: 
\ 

orbitscreenrc 
orbitscreen.html 
orbitscreen.@ 
aps.icon 

The last three are for the help package 

There should be subdirectories pv for PV and lattice files and snap for snapshot files. There may 
be a similar set of subdirectories, xorbitlpv and xorbitlsnap, for files used with Xorbit simulation. 

All of these files may be located elsewhere if desired. See configuration. 

... 



The help package also refers to configuration files: 

pv/par.bpm.pv 
pv/par.lat 
snaplpar.bpm.refsnap 

that are assumed to be in subdirectories, pv and snap, relative to the location of orbitscreen.html. If they 
are not there, you will not be able to view them from Mosaic. 

The executable file, orbitscreen, should be located in a directory somewhere in your $PATH. 

The application defaults file, ControlApp, should be located as specified in the section on the 
application defaults file. You can specify personal modifications to the resources in this file in your 
.Xdefaults (or equivalent) file or in your own ControlApp fde in your home directory. (See an X 
Windows manual for the involved search path that X uses to find resources.) 

Configuration 
Exactly what is displayed in Orbitscreen is defined via three types of files. There are PV files 

and lattice files, which are described below. There is also a configuration file that defines what appears in 
the Filenioad menu as well as where the default PV files, lattice files, snapshot files, and the help files are 
located. 

The program looks for the configuration file first in your home directory with the name 
.orbitscreenrc (with a dot). If one is not found, it next looks in the directory given in 
$ORBITSCREENHOME if it exists, otherwise in the current working directory, for a file named 
orbitscreenrc (with no dot). If it still has not found one, there will be no options in the F i l a a d  menu 
except Custom; the PV and snapshot files will be assumed to be in subdirectories, pv and snap, to the 
current working directory; and the help files will be assumed to be in the current working directory. 

This configuration file is an SDDS2 file and has two parameters: OSPVDirectory, which 
specifies the directory for the PV. and lattice files, and OSSnapDirectory, which specifies the suggested 
directory for the snapshot files. (Independently of these settings, Custom PV, custom lattice, and snapshot 
files may be read from or written to any directory by changing the filter in the file dialog box.) There are 
corresponding parameters, OSXPVDiirectory and OSXSnapDirectory, which specify these directories if 
Xorbit simulation is used. If the first two parameters are not specified and $ORBITSCREENHOME 
exists, then they will default to $ORBITSCREENHOMElpv and $ORBITSCREENHOME/snap,. 
respectively, and will default to Jpv and h a p ,  respectively, otherwise. If the Xorbit parameters are'not 
given, they wilLdefault to whatever is used for OSPVDirectory and OSSnapDirectory. 

There is also a parameter, OSHelpFile, which specifies the location of the Mosaic3 HTML help 
file. This file should be in $ORBITSCREENHOME/orbitscreen.html. It defaults to 
$ORBITSCREENHOME/orbitscreen.html if $ORBITSCREENHOME exists and to 
Jorbitscreen.htm1, otherwise. 

2SSDS stands for Self-Describing Data Sets and is a format developed by Michael Borland to provide a 
flexible and standard, general purpose, file format. There are routines available for reading and writing 
SDDS files. 
3This manual was designed to be printed and also viewed on-line in Mosaic. Mosaic is an information 
browser that connects to many information sites on the Internet and World Wide Web. It was developed 
at the National Center for Supercomputing Applications at the University of Illinois. 
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‘ If any of these file locations are specified through the above parameters, it is suggested that the 
full pathnames be used. 

There are two columns, OSPWie and OSPVMenuLabel, which give the name of a PV file 
(without the path) and the label that will appear in the F i l e b a d  menu in order to use this file. These PV 
files will be expected to be in the OSPVDirectory. If these columns are not there, there will be no 
options in the Fi lehad menu except Custom. 

An example configuration file should be located in $ORBITSCREENHOME/orbitscreenrc. 

PV Files 
The PV files specify what process variables are to be displayed in each of the display areas. They 

also specify the multiplier to be applied to the data, the headings, the default scale, and the units labels for 
each area as well as the lattice file to be used if the process variables correspond to lattice elements. The 
PV files are valid B U R P  request files. You can make new PV files containing any process variable you 
wish to monitor, and you can save them in your own directories. These can then be read in from the 
File/Load/Custom menu. If you start with an existing PV file, it should be obvious where the changes are 
to be made. An example PV file should be located in $ORBITSCREENHOME/pv/par.bpm.pv. 

The possible parameters that may be specified in a PV file are: 

OSFileType: A required, fixed value of type string that should be “ORBITSCFEENPV”. 

OSHeadingl, OSHeadmg2: A fixed value of type string that specifies the description that appears above 
each of the upper display areas. 

OSScaleFactorl, OSScaleFactor2 A fmed value of type double by which all the raw data will be 
multiplied before being displayed. The units label to be displayed to the right of the Scale button is 
obtained from the units field of these two parameters. For example, to convert raw data in millimeters to 
displayed values in meters, the fixed value would be 0.001, and the units would be “m”. If this parameter 
is not supplied, it will be taken as 1.0. ’ 

OSScalel, OSScale2 A fixed value of type double that specifies the scaling on the Scale button (the 
number of units corresponding to full scale). If this number is not one of the available values, the next- 
higher available value will be used. If this parameter is not supplied, the former number on the Scale 
button will not be changed. 

\ 

The PV file will have one more column for StatusName if status is implemented. 

Lattice Files 
The lattice files contain information about all the basic lattice elements, including their 

longitudinal coordinates. This information is used to draw the symbols for the magnets in the Zoom 
Window and to determine the longitudinal coordinates corresponding to the process variables, so that the 
values can be shown in their true relative locations in the Zoom Window. There should only be one lattice 
file for each ring so you should have little need to make one yourself. An example lattice file should be 
located in $ORBITSCREENHOME/pv/par.lat. 

4BURT is the backup and restore program for the APS control system. 



The columns that must be specified in a lattice file are: 

S: A required column of type double that is the position of the start of the element in meters. 

Length: A required column of type double that is the length of the element in meters. 

SymbolHeight: A required column of type short that is the relative height of the symbol for the element. 
Correctors should use 1, quadrupoles should use 2, and sextupoles should use 3. The sign of the number 
should indicate the sign of its strength. 

Name: A required column of type string that is the name of the element. Orbitscreen will match elements 
to process variables by looking for this string as a substring of the process variable name. 

The parameters that must be specified in a Lattice file are: 

OSFileType: A required, faed value of type string that should be ‘‘ORBITSCREENLATTICE”. 

Nsectors: A required, fixed value of type short that is the number of sectors into which to divide the 
lattice for the purposes of scrolling. 

Stotal: A required, faed value of type double that is total length of the lattice in meters. 

Ring: A required, fixed value of type short that is 1 for a ring and 0 for a beamline. 

There is a program, xintolat, that converts Xorbit input (.xin) files to lattice files. Its usage is: 

xintolat [-h] wZel.xin] @Ze2.lat] 

-h Help 

If the filenames are not specified, the program will prompt for them. 

Snapshot Files 
Snapshot files may be saved via the Fi lmri te  menu. Depending on options in the menu, these 

files could contain the values of the displayed process variables at the current time, at the time the orbit 
was saved via the Options/Save menu, or at the time given in another snapshot file read via the FilelRead 
menu. These snapshot files should be equivalent to the ones generated by BURT. They can be used to 
restore the process variables in them if these process variables are capable of being restored. monitor 
readings and corrector read backs cannot be restored, for example. Corrector set points can.) You can 
save snapshot files in your own directories. An example snapshot file should be located in 
$ORBITSCREENHOME/snap/par.bpmsnap. 

The snapshot file will have two more columns, StatusName and Statusvalue, if status is 
implemented. 

Application-Defaults File 
The applicationdefaults file for Orbitscreen is named ControlApp. It is needed in order to run 

Orbitscreen. The usual place for such files is in /usr/lib/Xll/appdefaults. You may also have an 
additional applicationdefaults file named ControlApp in your home directory. You can put your own 
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resource customizations for Orbitscreen in this file or in your .Xdefaults file. If you do not understand 
about resources or applicationdefault files, see your local administrator. 

Status Indicators 
Orbitscreen can be made to display the status of BPM readings. The status values must be 

available in a process variable which can have the enumerated values: 

0 = InValid 
1 = Valid 
2 = OldData 

In order to enable this capability there must be an additional string column in the PV file called 
StatusName. Each entry in this column should contain the name of the process variable that has the 
status information for the process variable that is to be displayed. If there is no status name or you don't 
want to use it, the entry should be a "-". If the column is not there, there will be no indication of status 
other than for process variables that are not connected. 

When this has been done, the display should be the same as usual when the data is Valid. 
Otherwise there will be color-coded markers that indicate the status. Snapshot files will have two 
additional string columns, StatusName and Statusvalue, to indicate the status. In addition to the three 
values above, Statusvalue may also be NotConnected if Orbitscreen was unable to find either the process 
variable for the data or for the status. 

Because of the asynchronous nature of EPICS, there is no guarantee the status displayed in 
Orbitscreen is exactly coordinated with the data, but it should be close. 

Color Code 
Red: 
Blue: 
Magenta: . . 
Green4 
Black : 
Grey30: 
Grey50: 

Data points in the upper display area 
Data points in the upper display area 
Stored data points in the.upper display area 
Stored data points in the lower display area 
Data points that are not connected (large, square markers) 
Data points that are Invalid (large, round markers) 
Data points that are OldData (large, round markers) 

Xorbit Simulation Mode 
Xorbit can in principle be made to simulate the orbit for any of the lattices in the A P S ,  although 

not all of them have been implemented at this time. To do this there is a special database of process 
variables in an IOC. These process variables closely resemble the real process variables for monitors and 
power supplies and have the same names with "Xorbit:" attached. When set points for magnet power 
supplies are changed via the control system, Xorbit is notified and calculates the appropriate orbit. It then 
supplies the new readings to the read backs for the power supplies and monitors. This process takes about 
4 seconds for the over 3000 process variables for the storage ring, but is essentially instantaneous for the 
PAR. 

The simulation includes the effects of random magnet displacements and monitor offsets and 
includes nonlinear effects from the sextupoles. This simulation capability allows physics application 
codes to be tested and debugged on something resembling a real system without disturbing the real system 
or before the real system is operational. 



Orbitscreen may be run in Xorbit simulation mode by specifying -x on the command line. In this 
mode it attaches "Xorbit:" to the front of all process variable names. Consequently, configuration files 
may be tested with Xorbit with no change to the files for a lattice that has been implemented in Xorbit 
(provided the actual names and the names in the Xorbit database follow the same naming conventions). 

Xorbit calculates magnet strengths in theoretical units (e.g. radians for corrector magnets) 
whereas the real process variables correspond to power supply currents (Amperes). The relationship 
between the current and the strength depends on the magnet hardware and the energy of the beam. The 
Xorbit database has been designed to convert between theoretical units and Amperes, taking these 
relationships into account. The relationship between magnet strength and current is taken to be linear in 
this databaset. This is a good approximation for correctors, but may be inaccurate for the larger magnets 
away from their reference values. 


